Tutorial - I.Basics
Part 1 -  Digital Audio  - Part 1
What is sound?

Sounds are pressure waves of air. If there wasn't any air, we wouldn't be able to hear sounds. There's no sound in space.

We hear sounds because our ears are sensitive to these pressure waves. Perhaps the easiest type of sound wave to understand is a short, sudden event like a clap. When you clap your hands, the air that was between your hands is pushed aside. This increases the air pressure in the space near your hands, because more air molecules are temporarily compressed into less space. The high pressure pushes the air molecules outwards in all directions at the speed of sound, which is about 340 meters per second. When the pressure wave reaches your ear, it pushes on your eardrum slightly, causing you to hear the clap.


A hand clap is a short event that causes a single pressure wave that quickly dies out. The image above shows the waveform for a typical hand clap. In the waveform, the horizontal axis represents time, and the vertical axis is for pressure. The initial high pressure is followed by low pressure, but the oscillation quickly dies out.

The other common type of sound wave is a periodic wave. When you ring a bell, after the initial strike (which is a little like a hand clap), the sound comes from the vibration of the bell. While the bell is still ringing, it vibrates at a particular frequency, depending on the size and shape of the bell, and this causes the nearby air to vibrate with the same frequency. This causes pressure waves of air to travel outwards from the bell, again at the speed of sound. Pressure waves from continuous vibration look more like this:
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How is sound recorded?

A microphone consists of a small membrane that is free to vibrate, along with a mechanism that translates movements of the membrane into electrical signals. (The exact electrical mechanism varies depending on the type of microphone.) So acoustical waves are translated into electrical waves by the microphone. Typically, higher pressure corresponds to higher voltage, and vice versa.

A tape recorder translates the waveform yet again - this time from an electrical signal on a wire, to a magnetic signal on a tape. When you play a tape, the process gets performed in reverse, with the magnetic signal transforming into an electrical signal, and the electrical signal causing a speaker to vibrate, usually using an electromagnet.

How is sound recorded digitally ?

Recording onto a tape is an example of analog recording. Audacity deals with digital recordings - recordings that have been sampled so that they can be used by a digital computer, like the one you're using now. Digital recording has a lot of benefits over analog recording. Digital files can be copied as many times as you want, with no loss in quality, and they can be burned to an audio CD or shared via the Internet. Digital audio files can also be edited much more easily than analog tapes.

The main device used in digital recording is a Analog-to-Digital Converter (ADC). The ADC captures a snapshot of the electric voltage on an audio line and represents it as a digital number that can be sent to a computer. By capturing the voltage thousands of times per second, you can get a very good approximation to the original audio signal:

[image: image2.png]



Each dot in the figure above represents one audio sample. There are two factors that determine the quality of a digital recording:

· Sample rate: The rate at which the samples are captured or played back, measured in Hertz (Hz), or samples per second. An audio CD has a sample rate of 44,100 Hz, often written as 44 KHz for short. This is also the default sample rate that Audacity uses, because audio CDs are so prevalent.

· Sample format or sample size: Essentially this is the number of digits in the digital representation of each sample. Think of the sample rate as the horizontal precision of the digital waveform, and the sample format as the vertical precision. An audio CD has a precision of 16 bits, which corresponds to about 5 decimal digits.

Higher sampling rates allow a digital recording to accurately record higher frequencies of sound. The sampling rate should be at least twice the highest frequency you want to represent. Humans can't hear frequencies above about 20,000 Hz, so 44,100 Hz was chosen as the rate for audio CDs to just include all human frequencies. Sample rates of 96 and 192 KHz are starting to become more common, particularly in DVD-Audio, but many people honestly can't hear the difference.

Higher sample sizes allow for more dynamic range - louder louds and softer softs. If you are familiar with the decibel (dB) scale, the dynamic range on an audio CD is theoretically about 90 dB, but realistically signals that are -24 dB or more in volume are greatly reduced in quality. Audacity supports two additional sample sizes: 24-bit, which is commonly used in digital recording, and 32-bit float, which has almost infinite dynamic range, and only takes up twice as much storage as 16-bit samples.

Playback of digital audio uses a Digital-to-Analog Converter (DAC). This takes the sample and sets a certain voltage on the analog outputs to recreate the signal, that the Analog-to-Digital Converter originally took to create the sample. The DAC does this as faithfully as possible and the first CD players did only that, which didn't sound good at all. Nowadays DACs use Oversampling to smooth out the audio signal. The quality of the filters in the DAC also contribute to the quality of the recreated analog audio signal. The filter is part of a multitude of stages that make up a DAC.

How does audio get digitized on your computer?

Your computer has a soundcard - it could be a separate card, like a SoundBlaster, or it could be built-in to your computer. Either way, your soundcard comes with an Analog-to-Digital Converter (ADC) for recording, and a Digital-to-Analog Converter (DAC) for playing audio. Your operating system (Windows, Mac OS X, Linux, etc.) talks to the sound card to actually handle the recording and playback, and Audacity talks to your operating system so that you can capture sounds to a file, edit them, and mix multiple tracks while playing.

Standard file formats for PCM audio

There are two main types of audio files on a computer:

· PCM stands for Pulse Code Modulation. This is just a fancy name for the technique described above, where each number in the digital audio file represents exactly one sample in the waveform. Common examples of PCM files are WAV files, AIFF files, and Sound Designer II files. Audacity supports WAV, AIFF, and many other PCM files.

· The other type is compressed files. Earlier formats used logarithmic encodings to squeeze more dynamic range out of fewer bits for each sample, like the u-law or a-law encoding in the Sun AUformat. Modern compressed audio files use sophisticated psychoacoustics algorithms to represent the essential frequencies of the audio signal in far less space. Examples include MP3 (MPEG I, layer 3), Ogg Vorbis, and WMA (Windows Media Audio). Audacity supports MP3 and Ogg Vorbis, but not the proprietary WMA format or the MPEG4 format (AAC) used by Apple's iTunes.

Tutorial - I.Basics
Part 2 -  Rules of Audacity  - Part 2
If you'd like to get straight playing an imported file or recording something, you can skip this section and come back later.

Whenever you work with Audacity, there are some rules you should remember:

1. One clip per track

A clip is simply a piece of audio material. Imported, recorded, split or duplicated from another track, one track can only carry one piece of audio at a time. You can extend it by pasting material or inserting silence in to it, or cut a piece away, but it will always be one continuous piece of audio.

2. Audacity always records to a new track

This new track is opened at the bottom. You'll have to zoom out and then resize the track view of the bottom most track to see what is recorded. You can actually use the window sliders at the bottom and right to do this after starting to record, but this way no performance will be lost to the windowing system.
I suggest hitting CTRL+F to get an overview of the entire project as well. This only affects the horizontal zoom by the way(left-right zoom). There is no way to zoom out vertically without using the mouse yet.

3. Edit/Duplicate will not create a new audio file

This may not seem a big deal, but it is if you're editing a large live recording.

What Audacity does is reference the original audio material until you actually perform some kind of edit on it, such as cutting a piece away, or using any effect on it. One thing to remember is the UNDO function. You can undo/redo stuff as many times as you like, and yes, even after you have saved your project.

You may ask what happens if you do, for example, cut away a piece or mark off a 30 minute piece and split it to a new track. It only writes changed data to disk. Since Audacity works with chunk of audio data of around one megabyte in size, this happens quite fast. Rest assured that the only big waiting period might be the importing of large audio files.

Tutorial - I.Basics
Part 3 -  Setup, Audio Import and Playback  - Part 3
1. Create a new project

This is very important!

Audacity writes all the changed and recorded audio to a directory called Projectname_data, which is located right where you saved the project file itself.
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 and choose a location and filename for your project.

Please note that when you startup Audacity fresh, only the " Save As..." menu option is available.

To save your project later on, you can also use the keyboard shortcut : CTRL+S
2. Check the Preferences

Again, this is very important!

	Press CTRL+P or go to ...
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	...then check if the right output is selected : 
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	...set the sample rate of your choice... (44.1 kHz is the default)
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	...and here's a crucial screen :
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The File Formats settings need discussing at this point.

When importing uncompressed audio, there are two ways to do it. "Make a copy of the original before editing" means, that Audacity actually copies the entire audio file that you imported in to its project data directory and in the process sets up the little overview graphics, whose descriptions get stored in the project data directory too.

The second way is to use the original imported audio. You may think we're actually editing this file, but no we aren't. In fact, Audacity will now read the imported file once and simply create the graphics overviews for them in the data directory, and subsequently write to disk all the audio data that you change. The original file is only used for playback. All audio that remains unchanged will be played from the original file.

The advantage of choosing to make a copy of the original is that you avoid trouble, should anything in the original file change.

For example, should you accidentally delete the original file, you're lost.

You have to make up your mind before you start a project. Choose to make a copy of all imported files, and you'll use more space on your hard disk(s), but it will be easier to back up the project too, because all files that have anything to do with your project will be in the project data directory.

The Uncompressed Export Format can be set to WAV or AIFF for now. Please check the fileformats page for further information on export formats.

We'll ignore the Spectrogram settings for now. The Directories setting can be ignored as well for now, because all it sets is the directory to use for recordings, undo data and other stuff, if you haven't yet saved your project. Since we already saved our project, this setting is of no importance to us, though you may want to set it properly later on. Initially this is set to a folder called "audacity_temp_1.2" in the system temporary directory.

3. Import an audio file

There are three ways to do this:

1. Simply drag and drop the audio file in to the Audacity window. (If you're using Mac OS 9 or X, drag the audio file to the Audacity icon instead...)

2. Select Import Audio ... in the Project menu.

3. Use the keyboard shortcut : CTRL+I
Audacity can import WAV, AIFF, AU, IRCAM, MP3 and OGG files. Please refer to the fileformats page for further reference on these audio formats.

4. Playback

The imported file should now be displayed in an audio track. The track will look a little like this, depending on what you imported :
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Trackpanel and Waveform Overview of the imported Track
If you're not sure where to find audio material, simply rip some off a CD, or in Windows, check the Media folder in the directory of your Windows installation.

Now click on the green Play button 

 at the top and you should hear the file you have just imported.

Tutorial - I.Basics
Part 4 -  Recording with Audacity   - Part 4
1. Create a new project

Save an empty project. Or simply use the one from the previous part. Remember, that if you don't save your project before you start recording or importing, that all recordings, edit and other files will be written to the directory set on the Directories tab of the preferences.

2. Check the preferences

Make sure your playback and recording device are set. If you're going to record a stereo signal, set the number of channels to record to 2 (Stereo) on the Audio I/O preferences.

When picking a device to record from, make sure you've set up all the connections properly, such as plugging a microphone in to the Mic Input, and any other device in to the Line Inof your sound card. Then check that the gain level knob(the amount by how much the input should be amplified) of the mixer of your soundcard is set right.

Since most soundcards can mix the inputs back in to the outputs, the easiest way to test your microphone is to speak in to it while playing with your sound card mixer. The sound card mixer is a piece of software either provided by the sound card maker, or by the operating system you're using. The Windows mixer is pretty straight forward, though some soundcards bring their own along. The Mac's mixer is controlled via the Sound Control Panel, and the Linux users have a variety of mixer applications at their disposal. Just make sure they work before yelling at your screen that nothing works.

3. Hit Record

	Click on the red Record button
	


	to begin recording.

	Click on the blue Pause button
	


	to pause the recording. Press it again to continue.

	Click on the yellow Stop button
	


	to cease recording. The cursor will return to its previous position, before the recording was started.


That's it. You can now play around with your recording and explore the editing capabilities of Audacity. Remember that you can use the Undo function almost without limits whilst the project is open.

II.Editing for Beginners
Part 1 -  Introduction  - Part 1
Sound Editing in the "real world"

Sound editors clean up dialogue tracks, cut layers of special effects, place sounds at certain times, create ambiance tracks by cutting out unwanted stuff and mixing in interesting or necessary sounds. Music production engineers may cut pieces of vocals away or shift them to a another spot in a song.

Editing is about cutting, placing, fading, cross-fading, shifting, duplicating and adjusting the volume (also referred to as level) of audio material. Mixing is a form of editing too of course.

Here is an example of what is done in sound editing during the production of a television show or film. In the next part we will run you through a few of those techniques in Audacity.

The Path of Sound in Film and TV Postproduction

Film and TV crews have at least two people present that take care of recording sound during principal photography of a show. Principal photography is usually shooting the scenes with actual live actors or real backgrounds by the way.

Sound in Principal Photography

The first person is the boom pole operator. The boom pole is an extendible stick with a microphone attached to it. This is used to capture dialogue either during filming or not. When not filming, it might be capturing off-scene dialogue or retakes of lines that the actors flunked during actual film takes. The more expensive the show is and the more time there is to do the work, the more people will resort to looping those takes, which is recording those lines in a sound studio environment instead of a film studio or location.

The second person is the sound mixer, who usually sits in a place farther off from the shooting and records the sound captured by the boom pole operator, either via cable or wireless devices to tape,optical disks or hard drive.

This is the raw sound material of a show. It is called production sound and the only desirable parts it usually contains are dialogue and body sounds. In post production, depending on the complexity, budget size and time, almost everything you hear except for the dialogue and some body sounds, are added later during ...

Post Production

This is where most of the stuff we'll be describing for Audacity will happen. You've got the recording. Now what ?

After the visual part of the show is cut, the first of which usually isn't the final one, it is handed to the sound editor. In TV shows, you'll usually have one or two people for this, for major film productions a whole bunch more, for which tasks will be subdivided on a finer level.

Raw sound - Cleanup time

No shows do without film edits and many have plenty of them.

Scenes may be shot with with one or more cameras and mics. Actors might have flunked their lines and picking up shooting prior to the mistake might be chosen or the entire sequence reshot. The film editor may have chosen parts from different takes for the cut of the scene. The action might be moving along at the wrong pace and the film editor shortened or stretched parts of a scene.

The sound editor makes sure transitions between cuts are smooth. He or she removes undesired sounds, such as breathers of the same person that overlap from one film edit to the next.

Material is cut away that contains unwanted sounds, such as creaking chair legs and sharp impacts of objects on tables and floors. Some of these may require looping of dialogue in the studio, because the noise may have been intolerable. Also, material may sometimes be denoised. The most sophisticated methods remove the whirring of the camera motors from takes. It is used as sparingly as possible though.

It's always desirable to get the best possible sound from the start, which is the recording stage.

Adding stuff - the really big deal

After this cleanup is complete, sounds are added.

The first is ambiance. Just close your eyes and listen to the sound around you. That's ambiance. Sophistication of ambiances rises with budgets. From premixed to over a dozen tracks, you'll find it all in TV shows and feature films. In any indoor scene with a lot of people in the background, nobody except for the actors being filmed will actually talk. That flurry of conversation is added later on.

Next comes foley. These are clothes rustling (body sounds), foot steps and objects being handled. People that have the ultimate edition of Terminator 2 will know that all of Arnold Schwarzenegger's footsteps and rustle of his leather clothing were created by a five foot woman. These people are usually called foley walkers or foley artists.

The foley editor then cleans these sounds, chooses the most fitting takes and makes sure they all sync to the picture properly. The foley mixer then does his/her thing.

Next come effects. Foley are effects too, but they are a special category and can best be described as live created studio effects. Effects are usually more heavily edited and recorded from all kinds of places. A lot of effects are created by layering sounds on top of each other, changing their pitch and loudness, editing bits out and adding others.

Many effects you'll hear are phone and door bells ringing, mobile phone beeps, doors of houses and cars opening and closing, weapon shots, slaps, car skids, machines of any kind, space ships flying around, explosions, to name a few.

For example, a friend of mine and I created the sound of a small wooden rowing boat hitting a larger wooden sailing ship and scraping along its side by pitching down a knock on a large wooden door for the impact of the rowing boat and ship, and pitching down the sound of a skateboard rolling and scraping along a halfpipe.

The techniques required to properly handle sounds like these are used in all kinds of productions. Audio books, music production, sound effects creation ... you name it.

For more on this subject, read the Audio Post FAQ at www.filmsound.org.

So let's jump in to the fray and look at how you can handle your sounds in Audacity.

II.Editing for Beginners
Part 2 -  Cut, Copy and Paste  - Part 2
From here on you may encounter funny letter combinations in boxes like this.

These are keyboard shortcuts to the functions presented to you in the text. These can be either single keys (e.g. SPACE) or combinations that need to be held down at the same time(e.g.CTRL+C). You can usually create your own. Check out the this page for more details.

The most basic editing step is cut and paste. It's what people did with tape and it's easy with data in computers, so take a look at these basic operations, referred to as Cut, Copy and Paste. The next page will handle Silence, Duplicate and Split. You may also want to check out the reference section, so you'll know where to find all the tools and how to resize tracks for example.

It is assumed that you have a project open and that at least one track of audio material is present.

Let's take a look at this example of an Audacity window:

The View
The Audacity Window
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As you can see by the graphics above, the 
selection tool 
 is selected. We'll use that to select the part we want to cut or copy, then later, after spliting the selection to a new track, we'll change to 
time shift tool 
 to move the audio clip around inside its track.

For now, let's say we want to cut out a bit in the middle. First we've got to select it.

Making a selection
To select the part you wish to cut, copy or paste to, use the 
selection tool 
. If it's not activated, do so now by clicking on it in the toolbar.

Now press and hold the left mouse button while you drag the mouse to mark an area.

This area is darker than the surrounding area of the clip. Note, that even though you can mark an area larger than or extending beyond the actual audio clip in the track, the operations will only work on the actual clip. Playback however will work outside the clip.

Press the space bar to listen to the audio in the marked area. 
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To extend or contract your selection, hold down the SHIFT button and click on the area you wish your selection to extend or contract to.

If you click at a spot that is on the right hand side from the middle of the current selection, you will set the right hand boundary of your new selection.

Cutting the selection
	Cut the selection by selecting "Cut" from the Edit menu ...
	 or press CTRL+X.


	Before the cut
	After the cut
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To undo this operation, select Undo in the Edit menu or press CTRL+Z
Copy will copy the selection to the clipboard.

You can then paste that data back in to any track by clicking where you want this audio to be inserted and select Paste in the Edit menu,

or press CTRL+V.

Thus pasting is the opposite of cutting. You can also copy material, make another selection with the mouse and then paste. This will replace the selected material with the contents of the clipboard, no matter how short or long either of them are.

during all operations of this kind, the bottom row of the screen will display two things, namely the start time and the end time of your selection. The display to the left if that called "Project rate:" and its value, defaulting to 44100, can be changed by clicking on that number and selecting another from the drop-down menu. This sets the sample rate of everything you produce in audacity.

All files, no matter which will be played at the project rate, and exported at that rate. Should the sample rate of a track be different from the Project Rate, these tracks will be resampled to the Project Rate as the project is played back or exported.

Audacity will not change the sample rate of any imported audio. If you want to change the rate of an imported track for any reason this can be done using the Rate option on the track pop-down menu.

II.Editing for Beginners
Part 3 -  Silence, Duplicate and Split  - Part 3
Silencing unwanted sources

This operation flattens the selection. It essentially is a cut operation without deleting the selection completely. After all, if you cut a second away, nothing remains. Using the Silence operation will still leave you with a flatlined area.

When silencing parts between vocal lines, please keep in mind that a sudden drop in background ambiance can have an bad effect, so at the very least fade the area around the silenced part, to minimize that effect. Rules to start with are, fade in quickly and fade out slowly.

Alternately, use the envelope tool to lower the volume in that area. That way, you can comfortably change it later.

Keyboard Shortcut : CTRL+L
Duplicate

The selected area gets copied, a new track is created and the copied material is pasted in to that new track at the same point in the timeline.

To illustrate, here's the image from the menu reference:
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The benefits of a duplicate are many. One of these is experimentation with effects.

Some of you may say "I can do that with the original track too". But you can't change the volume of your effect and original audio separately. If you put some Reverb on to your audio, you can only lower that processed audio in volume later on. If you duplicate the audio first and use the reverb on that(with 100% reverb and 0% original signal), you can freely change the volume for both the original and reverb signal.

Also, you can do weird and wonderful things to your duplicates to create special effects. You'll have two pieces of the same audio to work with. Silence parts, reverb another, phase a third, filter another and see how that sounds. It is so easy to duplicate a piece of audio and do weird things to it, so try it. Combining sounds produces magic.

A special note on performance :
The new piece of audio isn't actually copied on the hard disk. Audacity will still play from the original audio file(s) until you change a piece of it.

Keyboard Shortcut : CTRL+D
Split

This performs the same as Duplicate, but it also silences the selected material, after copying it to a new track. Again, here's the illustration from the menu reference:
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There are plenty of good uses for this function, but I'm not going to tell you about them here. You'll have to go to the next part for the meat of this tutorial.

Keyboard Shortcut : CTRL+Y
II.Editing for Beginners
Part 4 -  Splitting and Submixes  - Part 4
Moving bits of an Audio track

In all projects you'll be pushing your audio around at some point. Otherwise, what are you doing here ?

There are techniques, easily achievable with Audacity, to cover almost any kind shifting you'd want to do. In our example, we have a small sentence of speech, where the speaker made a pause after the first word. We'd like to eliminate that pause.

The part after the pause is selected
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Select
Then the split function is used to pop the selected audio to a new track
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Split
The Time Shift Tool 

 is selected and the audio on the lower track is moved left.
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Move Audio and select for fading
	Now, it's a good idea to listen to the two tracks individually for breathing sounds for example.

Use the solo button of the tracks for this. Then listen them both in the mix. Again, you can use the solo buttons for this.

If you have a lot of other tracks playing at the same time, press the solo buttons on both tracks. There should be no over lapping or cut-off breathing sounds.

When you're satisfied, fade out the last two thirds of the overlapping upper part of the track, and fade in the first two thirds of the lower overlapping audio.
	Two thirds, and not the whole overlapping audio, are chosen to keep the level of audio constant. If the whole overlapping parts were faded, you would get a level drop of 3dB in the middle of those fades.

You can check this out by taking a piece of music, duplicating it, and then fading the tracks, one fading out, the second fading in. In the middle of those fades, the level of the mix will drop audibly. Do a fade over last two thirds for the fade out and first two thirds for the fade in, and you probably won't notice any change in level.

Two thirds is a guideline, but not the law, so you may have to experiment a little.


Mixing it back together again

!!!Remember!!!
The final mix is done with the Export as WAV function in the File Menu. Here we'll be looking at creating submixes with the Quick Mix function.

You've done a lot of edits and now have dozens of little tracks with little bits and pieces here and there. It might look like this:

[image: image26.png][XJDuskTilD=

[XJDuskTiLD=

[XJDuskTiLD=

[XJDuskTiLD=

[XJDuskTiLD=

[XJDuskTiLD=

[XJDuskTiLD=

5] Dusk Til Dz





Bits and Pieces spread all over the screen
First four tracks selected for quick mixing
We can use the Quick Mix function in the Project menu to bring down the number of tracks. However, you don't need to mix everything in to one new track.

Select the tracks you want to mix together by SHIFT+click 'ing on the track panels. In the graphics above, the first four tracks are selected.

Then select Quick Mix. In this example I have quick mixed everything down to two tracks :
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Bits and Pieces, quick mixed down to two tracks
And thus, two submixes were created. Remember though, that we did this for convenience of not having to organize a large number or tracks.

If you still want to shift bits around later on, you should make sure that the parts being mixed to a track do not overlap, so you can split it away and edit it again later.

Tutorial - III.Common Editing Tasks 
Part 1 -  Quickies   - Part 1
This page will give you an idea of some of the possible things you can do with Audacity and walk you through the process.

	1. Splitting an MP3 into two separate files

	2. Mixing background music with a voiceover

	3. Recording harmonies with yourself

	4. Recording two sound sources on separate tracks


	Splitting an MP3 into two separate files

(Before you try to export MP3 files, read the section on Exporting MP3 Files for some important information on steps you need to do first.)

· Open the MP3 file.

· Select the part of it that you want to be the first file. Listen to it by clicking the Play button.

· While this part is selected, choose Export Selection as MP3... from the File menu.

· Now select the part you want to be the other song and Export again.

Mixing background music with a voiceover

Audacity makes it very easy to mix two different sounds together.

· Open one sound (for example, the background music).

· Select Import Audio... from the Project menu and open the other sound (for example, the voiceover).

· Listen to your sound using the Play button. Audacity automatically mixes them together.

· Choose the Time Shift tool and adjust the position of one track or the other until they're synchronized the way you want them. You can even move tracks around while they're playing.

· If you hear clipping which wasn't present in either of the original files, it means that the combined volume of the two tracks is too loud. Use the gain controls on the tracks to reduce the volumes until you don't hear clipping anymore.

· Export as a WAV or MP3 file.
	Recording harmonies with yourself

· Open the Preferences, click on the Audio I/O tab, and check the box marked "Play other tracks while recording new one".

· Click the Record button. Record yourself singing. Click Stop.

· Click the Record button again. The first track you recorded will play, but Audacity will also record a new track at the same time, allowing you to sing harmony with yourself.

· When you play the two tracks you recorded together, they probably won't be synchronized. This is normal and is not the fault of Audacity. To fix it, you will need to grab the Time Shifttool and slide one of the tracks around until it sounds right.

Recording two sound sources on separate tracks

· Open the Preferences, click on the Audio I/O tab, and make sure "Record in Stereo" is checked.

· Connect one sound source to the left channel of your soundcard and the other on the right. If you don't have an external mixer with a pan control, use a stereo/mono splitter cable.

· Record your stereo track.

· On the button with the track name is a drop-down menu. Select "Split Stereo Track" from this menu.

· Use the drop down menu again to change each track to mono.

· To position sounds in the stereo image use the pan control on each track.

· To export your recording in stereo you need to include at least one Stereo track. If necessary add a blank one using Project > New Stereo Track.

· Repeat as necessary for further tracks (see Recording harmonies with yourself above). If mastering from tape, a click recorded across all tracks will help you synchronize them inAudacity.


Tutorial - III.Common Editing Tasks 
Part 2 -   Editing Vocal Tracks  - Part 2
The Situation

	You have:
   Vocals, Speech or Wallas (fx made with voices)

You want to:
· remove inappropriate breathers, coughing, bad takes, parts you didn't like and bad noises

· use only the good parts of takes

· construct sequences from parts of different takes
	You can combine three ways of handling this:
1. Silence stuff you don't want.

2. Substitute it with,

· a piece of ambience to prevent a sudden hole in the sound texture

· more fitting breather, that works better, if you're cutting a breather away.

3. Use the envelope tool to create volume automation to pull down those parts, so they won't sound as loud in the end.


When do I use what ?

	The first option is a tool, but is rarely used by itself.

In audio books, radio interviews and sometimes in dialog for a film, the vocal tracks willstand alone in many parts of your project.

Therefore the second option is general practice. Many times, the third option is used as well (envelope tool). The holes you create with it are easier to control and change at later times, but still need to be filled up with replacement material.

When using the envelope tool, replacement material is usually overlayed by placing the filler material on another track right at the area in the timeline as the hole is. For this reason only silence unwanted audio if it's too obtrusive.

Bad takes are of course not usable, so usually you'll have to cut that stuff away.

Just remember, that cut and delete (cut without copying to the clipboard) work like cutting tape away and sticking the remaining pieces together. If you're doing things that require critical timing, you need to keep this in mind. Use the Silence function instead.
	Continuous sound is the key in those cases and having the ambience, even if it's just a bit of quiet dark noise, drop away in many parts by silencing them isn't going to sound as good as keeping a steady sound texture.

Therefore filling those holes with material on another track and fading the edges to make it all sound continuous is the preferred way to do it.

There are situations, such as vocals in a song, that you'd like to sound as clean as possible.

The best way is to have a very quiet recording room or location.

The second best way is to use volume automation to get rid of any unwanted stuff. It allows you to change or take back what you did after you have made those changes to the volume curve with the envelope tool.

With volume automation you can mute sections of the audio without actually making any edits to the audio data.


The Three Options - a quick How To

Silencing
· Select an unwanted piece of audio.

· Listen to it a couple of times, adjust your selection if necessary, and listen again.

· Select Silence from the edit menu or hit CTRL+L on your keyboard.

· Fade the edges of the audio beyond your selection to smooth it out.

· Listen to it. If it doesn't sound good, hit Undo or press CTRL+Z on your keyboard, and try again at fading those edges.

· Repeat this procedure for every part you don't want in your audio.

Substitution
· Silence all unwanted bits as described in the section above. Substitution expands and improves that option. Be sure to only silence the bits you don't want and don't forget to fade the edges around the silenced material. Then come back here.

· Now that you've silenced all unwanted, create a new audio track.

· Now find a piece of audio that'll work as a substitute for those deleted parts. This is usually a piece of ambience somewhere else in the audio track. The speaker might have made a longer pause, so look in those areas first. Select that bit and duplicate it.

· Using the time shift tool, move the duplicated ambience directly beneath the first silenced part in your vocal track.

· Now select the entire track by clicking on track panel just beneath the Mute and Solo buttons, and duplicate it. Mute that new track. This will be our filler for the next gap in the original track.

· Turn your attention back to the first bit of ambience, that is now right underneath the bit that we silenced in our vocal track.

Using the Envelope Tool
· Switch to the envelope tool
· Left-Click in to an area to create a new automation point or left-click on an existing automation point and drag to change the location of the point.

· The automation you have written remains bolted to the audio, so it will move along with the audio when you use the timeshift tool.

· An example:

[image: image28.png]


 
Using the envelope tool - an example
Tutorial - III.Common Editing Tasks
Part 3 -  Cutting up long Tracks  - Part 3
Long Recordings

	You have:
a large audio file
(a mix, a live recording, loads of voice overs recorded at once,...)
	You want to split it up in to parts that you wish to be separate audio tracks on a CD.

You can cut it up, so all the parts can be selected easily for export.


Splitting tracks for CD burning

Important: 
The selection format for the track that contains the audio clip to be split has to be : 
cdda min:sec:frames 75fps (from ruler)
Also, "Set Snap-To Mode" to "On (for ruler based formats)"

The result is that all the tracks you split away will lie within the grid that not only CD players can access, but that CD burning programs can actually burn without pauses.

That grid consists of 1/75th of a second, and beginnings and ends of any tracks on an audio CD cannot lie outside that grid.

Chop By The Numbers:

The goal is to split the long audio track in to several smaller tracks, so that for each track we want to have on the audio CD, there is one track in Audacity, which is easy to export.

1. Check and make sure that the right ruler format and Snap-To On is selected(see above) for track you're working on.

2. Place the cursor where you'd like the current track to end and the new one to start.

3. Go to the Edit menu and pick Select Cursor To End.

4. Go to the Edit menu and pick Split.

5. Repeat steps 1 to 4 as necessary.

You can also select from Start to Cursor instead. The track with the split away material will retain the ruler and Snap-TO setting of its source track.

Get Them Ready for Deep Fry:

Once all the tracks are created you need to Export each Audacity track that you wish to be on your CD. Check the preferences under "File Formats". The "Uncompressed Export Format" needs to be set to "WAV (Microsoft 16 bit PCM) (PC or Linux users) or "AIFF (Apple/SGI 16 bit PCM)" (Mac users).

1. Click on an empty part of the track panel(left of the wave display with the mute and solo buttons) of the track you wish to export. The contents of that track will be selected.

2. Go to the File menu and pick "Export Selection as WAV" (or AIFF if you're on a Mac). Pick your filename carefully. Number them accordingly, so it'll be easy to select them for burning the audio CD later on.

3. Repeat steps 1 and 2 for each track you wish to be on your audio CD

Roast, Toast or Burn Them

Open your CD burning application to burn your audio CD with the exported audio files. Make sure that no pauses are between those tracks. The only exception is the standard pause before the first track. That's required by the Red Book standard, so don't be alarmed. Burn and enjoy.

Conclusion

That was easy, wasn't it. Think you know how this could work a lot easier ? Do you need additional help or have suggestions on how to improve Audacity ? Drop us a line at audacity-help@lists.sourceforge.net.

IV.Effect for Beginners 
Part 1 -   A Virtual Room with Reverbs  -  Part 1
An example by the numbers

As an example I'd like to show you how to create a reverb for small club with a band.

Let's see what we have to do with parameters in the reverb fx in sample editors. First we determine some basics about the room we want to simulate.

Our room (the club) is about eight meters on all sides (for simplicity) and three meters high. The band will be playing no more than four meters away from us. The room volume will be about 200 cubic meters.

This means that the DIRECT SOUND will get to you within about 11 ms (milliseconds). This is the amount of time we'll need to take off the other values.

The first EARLY REFLECTIONS (off the left and right walls) travel around nine meters before reaching you, so they'll get to your ears about 15 ms later! (9 meters at 343 meters/sec -> 26 ms minus the 11 ms the DIRECT SOUND takes to travel to your ears).

I'm not taking the floor into account because of the obstacles, such as your own legs and a table, that prevent reflections of sound from the band from reaching you. It is also probable that your sitting close to a wall and EARLY REFLECTION time may drop considerably. Experiment and listen very carefully.

The reason I'm deducting 11 ms from the 26 ms is that in a sample editor we already have the DIRECT SOUND. In Cool Edit an EARLY REFLECTIONS parameter doesn't exist. In Soundforge however there are a few ER times to choose from. We choose whatever is closest to 15 ms. Freeverb unfortunately does not have an Early Reflections feature.

Please note that the timing of the EARLY REFLECTIONS are defined by the rooms characteristics such as shape and size. The sound colour of the EARLY REFLECTIONS is defined by the surfaces in the room.These are parameters that are available to professional reverbs only (hard- or software), so don't worry about not finding that stuff in great detail in either Soundforge's, CoolEditPro's or plugins of other editors.

The PRE-DELAY and REVERB TIME depend on more than just room size. Wall and floor material, as well as anything else that reflects, disperses and dampens sound will influence the reverb in quite a few ways.

Our club has lots of wood on it's walls and floor and people are sitting at tables and the air's probably filled with a little smoke (except in California :).

The REVERB TIME, a parameter found in almost all plugins, should be set to no more than one second. In small, crowded rooms where little REVERB occurs it is quite important to set the EARLY REFLECTIONS right. Experiment with the reverb time keep it lower than 1.2 seconds and above 0.7 seconds. Freeverb puts all this information in to the SIZE parameter.

The PRE-DELAY can be set to 30 ms or more. Larger rooms will develop REVERB later since the reflecting sound will travel a while before the reflections become hard to identify but it also depends on the reflecting materials. Freeverb once again doesn't know any Predelays, but since you're reading this to learn how things work, it's still worth spelling out.

Both Cool Edit and Soundforge have parameters referring to the DENSITY of the REVERB part of the sound. Materials such as polished marble will reflect the sound very well and disperse the sound very little. Wood disperses the sound a lot and a carpet practically swallows a large chunk of it. For our Club we need to set the density high since our material disperses the sound a lot(humans,wood and obstacles). No parameter like that in Freeverb and yet it sounds great. It's easy to use as well, so I don't really mind when using it.

Higher frequencies are swallowed a lot faster than low frequencies. Many reverb algorithms refer to this in some form or another. Cool Edit has the 'High Frequency Absorption Time' as a parameter for this. Sound Forge gives you a choice, whether to do this at all for both low and high frequencies and even lets you set them but doesn't provide any time parameters. Professional Reverb hardware such as Lexicon PCM 70,80&90 let you you control frequency and time of this, for low and high frequencies. Freeverb has the DAMPEN parameter for this.

This can effectively add to room's liveliness. A room full of people will absorb high frequencies a lot faster than an empty room, in which only the materials would make the difference, so in Cool Edit we'll set the 'High Frequency Absorbtion Time' very low, since we're in a crowded club. For Soundforge activate the 'Attenuate high frequencies above' box and set the frequency parameter to around 2000-2500 Hz. Experiment a bit. The higher this frequency and the longer the Absorbtion Time parameter in Cool Edit, the emptier and and colder your room will seem. In small rooms this can cause the room to sound very metallic. Sewer pipes and oil pipelines e.g.

The Reverb EQs are the final processing stage and can change the sound dramatically. These Hishelf and Lowshelf EQs are found in almost ANY Reverb plugin and hardware unit. Freeverb has both in form of Hipass and Lowpass filters. These are not EQs. The parameters change the target frequencies of the filters. Again, listen.

The last thing you have to do is set the balance between the WET signal and your original DRY signal. Here you can do as you please but remember that only very smoothed hard surfaces in big cavernous space create very loud reverbs. A church might do that if there aren't a big number of people and wooden benches in there, but a club doesn't :). Remember that in Audacity it is smarter to DUPLICATE the part you wish to add reverb to, and run the effect over that duplicate. The volume of that reverbed material is easier to control, so set the WET parameter in Freeverb to 0dB (-&rt;100%) and the DRY parameter to -endless(->0% left most slider position).

So when you create your next 'soon-to-be-the-hit' song or want to put things in perspective, be sure to check the possibilities of adding dimension and scope to your material through clever use of reverbs. Put your snare to the front, the piano a little to the back, and the sax just a little in front of the drums. Experiment. With these basics you'll be able to get better results in less time.

Btw, Snare always gets reverb. How much and what kind up to you, but it's generally good thing. It's also important to decide whether you're trying to simulate a real live band or doing a multitrack sound, which boasts all kinds of nice ideas, like doubling(another take of the same thing on top of the first take), extreme panning and in general NOT reality :).

Dry versus Wet

Have you heard of those silent rooms, where they test speakers and microphones ? They're great if you don't happen to be inside of one. After a few minutes you hear the blood in your ears roar like an ocean. You hear only your inner voice when you speak. The room swallows almost everything else. Most people can't stand being in a room like this for more than 10-15 minutes. I am told that this is very different to wearing ear plugs. Those only attenuate sound from the outside. A silent room kills it completely.

This room is horrible to listen to, because it basically features no room reverberation, i.e. it doesn't reflect anything at all. It doesn't reveal any information about its size or surface composition.

You may be surprised to know that many vocals are actually recorded in similar environments. Vocal booths are little rooms, in which the walls reflect sound as little as possible. During mixing, digital reverbs are used to create a virtual space.

Digital Reverbs

Audacity for Windows and MacOS9&X includes the VST plugin Freeverb, which is one fine reverb, and ideally suited to take your first steps with digital reverbs. It features simple controls that require little explanation.

For details about Freeverb, check out the effects menu page. For information on how digital reverbs work and what reverb is, check out this page of this manual.

Keeping effects on seperate tracks

You shouldn't use reverbs on original audio tracks. First duplicate the audio and use the reverb on that duplicate. The reverb should be set to output 100% WET (i.e. 100% effect signal and 0% of the original signal). That way, you can control how much reverb should make it in to the final mix, right up until the last minute.

V.Selecting and aligning 
Part 1 -  Selecting   - Part 1
Basic rules

Selecting can be done with the keyboard, the mouse or by combining the keyboard and mouse.

You need to have the 
Selection Tool 

 HYPERLINK "http://audacity.sourceforge.net/manual-1.2/toolbar.html" \l "selection" 
 activated for making a selection.

The exception is selecting the entire track by clicking on the track panel. The align functions all still work the same way no matter which tool is activated. However, making selections and placing the cursor still requires the Selection Tool.

The selection modifier key is SHIFT.

In a word processor or text editor, the SHIFT key is the modifier to turn any character that you enter via the keyboard in to an UPPERCASE character. In Audacity and most audio editing applications, holding down the SHIFT key means that any cursor movement or placement will result in a selection.

What follows are ways of making selections.

How do I ...

	select audio on one track ?

Place the cursor on the waveform of a track, hold down the mouse button, drag the mouse and release the mouse button. 
You can select audio with the keyboard as well, but may need to place the cursor with the mouse first. You need to hold down the SHIFT key and use the left/right cursor keys to expand the selection. Combine the former with the CTRL key (STRG on the German keyboard) to shrink the selection.

expand/shrink my selection ?

Hold the SHIFT key, then click and hold the mouse button. 
If you clicked to the left of the center of the current selection, you will now be able to move the left selection boundary with your mouse. The same goes for the right hand side of the selection center. Release the mouse button when you are satisfied. 
You can use the cursor keys as well. It works the same way as described in the previous item.

select from the cursor to the start of the track ?

Use the Start to Cursor function in the Edit menu.

select from the cursor to the end of the track ?

Use the Cursor to End function in the Edit menu.

select from the cursor to the start of the project ?

Hold the SHIFT key and click on the Skip to Start button.

select from the cursor to the end of the project ?

Hold the SHIFT key and click on the Skip to End button.
	select all the audio of a track ?

Click on the track panel. The resulting selection will be confined to the contents of that track.

select all the audio of two or more tracks ?

It cannot be done precisely right now, if one track isn't within the range of the other. It actually doesn't have to be, because of the group functions in the Align menu, but more of that later. 
If the start and end of one track is within the start and end of the other, simply select the longer track, then SHIFT + click the second track panel. 
If the start and end of one track is not within the start and end of the other, select the one track, then expand the selection by SHIFT + clicking in to the second track until the selection encompasses all the desired material.

select all the audio of the project ?

Use the Select All function in the Edit menu, or hit CTRL+A.


